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The purpose of this document is to explain in gory detail how to export a Spotify Playlist to a 
comma-separated value (.CSV) file, also known as a comma-delimited file. This is the first step 
that is needed in order to do whatever you want to do with this data. I have no idea why Spotify 
does not offer this functionality, but since they do not, below is how to accomplish this task. 
 
You may be wondering why would anyone want to go through all of this trouble. Some of my Spotify 
playlists are quite large. I often forget if I already added a certain song to them, and 
sometimes add the same songs more than once. I don't want any song in there more than once. The 
easiest way to see if they are in there more than once is to be able to sort by group name 
and/or song name. Yes I know, I can be pretty anal about some stuff. 
 
 
1) Go to this website and follow the instructions: 
 
​ https://watsonbox.github.io/exportify/ 
 
If you are worried about allowing some strange site to have control of your Spotify account, it 
really is of no concern, especially if you go into your Spotify settings immediately afterward 
and delete the permission for the site so it no longer has access. To do this, follow these 
instructions (these instructions work with the web app, and may be different on a phone app or 
the Spotify application): 
 

https://www.spotify.com/account/apps/ 
 
If that link ever ends up not working, you can go there manually: 
 
a) Go to your Spotify profile. Usually, you can get there by clicking on your Spotify account 
name. 
 
b) Click on "VIEW ACCOUNT". 
 
c) Click on "Apps" over on the left side. 
 
d) Click on "REMOVE ACCESS" for the "Apps" you no longer want to have access to your Spotify 
account, in this case, "Exportify". 
 
DONE! 
 
- - - - - - - - - - - - - - - - - - 
 
Now you have your CSV file full of all the song information that you have in your playlist. 
 
If you have no clue what to do with this file, then perhaps you might want to do what I did, and 
add it to a spreadsheet, so you can sort by item and display it in different ways to best suit 
your needs.  Such as sorting by the artist's name alphabetically, or by song name, or song 
length, Etc… 

 

https://watsonbox.github.io/exportify/
https://www.spotify.com/account/apps/


 
Assuming you have a Google/GMail/YouTube account (if you don't, crawl out from the rock you've 
been living under and create one! They are free, you ninny!), go to this address and login: 
 
​ https://sheets.google.com/ 
 
1) Click on the rainbow-ish plus sign to create a new "Blank" spreadsheet. 
 
2) Click on the "File" menu item at the top. 
 
3) Click on "Import". 
 
4) Click on "Upload", then follow the directions to either drag and drop your CSV file into the 
designated area, or click "Select file from your device", and navigate to where your CSV file is 
and select it. 
 
5) Select "Replace spreadsheet" for the Import location. 
 
6) Select "Detect automatically" for the Separator type. 
 
7) De-select the checkbox for the "Convert text to numbers" section. 
 
8) Click on the "Import data" button. 
 
After the upload finishes, you will now have your populated Google spreadsheet.  
 
- - - - - - - - - - - - - - - - - - 
 
Now you need to do a few customizations to it so things display correctly and in the order you 
want them in. 
 
1) First off, name your spreadsheet so you know what it is later. You do that by clicking on 
UNTITLED SPREADSHEET and typing in whatever you want to name it. I name them the same name as my 
playlist. 
 
2) Delete any columns you do not want or care about (see my recommended columns below). 
 
Keep in mind while deleting columns that there are two ARTIST columns. One is for single artist 
albums, and the other seems to be for compilations. So if you added a song from a compilation 
album containing songs from multiple artists, then that is what the second column is for. That 
is the column to delete in my opinion, because sometimes instead of showing the artist that 
performs that particular song, it might have other info in there.  
 
3) Arrange the columns in the order you want them to appear. Keep in mind that the original 
LENGTH column will be hidden, and the new one you create with the corrected time display is the 
one you will see. Same goes for the SONG TITLE column. If you have no idea what I am talking 
about, keep on reading and hopefully it will become apparent. I suggest you move any columns you 
hide to the end to get them out of the way. To move a column, click on the column letter and 
hold down the CTRL key while dragging the column to where you want it. 

 

https://sheets.google.com/


 
4) For each column name, you might also want to make all the letters capitalized, and maybe one 
or two font sizes larger, and/or make them BOLD, so they stand out as the name of what that 
column contains. I call this anal aesthetics, because although these steps are unnecessary, I'm 
anal about such things, in the way I'd like them to look. 
 
Since the top ROW tells you what that column contains, if you sort anything in any way, that row 
will move to somewhere else, and will no longer be at the top where it is useful. To make sure 
this row always stays on top, do this: 
 
1) Click on the first row, ROW 1, all the way on the left side.  This will highlight all of the 
columns in that row. 
 
2) Click on the "View" menu item at the top. 
 
3) Click on "Freeze". 
 
4) Click on "1 row". 
 
Now that row is locked in place, and will stay at the top even after you perform any sorting 
operations. 
 
- - - - - - - - - - - - - - - - - - 
 
To see examples of my playlist outputs, view them here: 
 
​ http://www.noyou.net/spotify/ 
 
- - - - - - - - - - - - - - - - - - 
 
If you care about having the song length shown, you'll need to do some weird trickery to get it 
to display in proper form, because for whatever reason, Spotify stores the song length in 
milliseconds instead of minutes and seconds. So the column that contains the song length info 
needs to have a formula and some formatting options applied to it. 
 
Long story short (too late, I know), in order to use a formula in a spreadsheet, you need to 
create a NEW column to apply the formula to, and in that formula you will reference the column/s 
that contain/s the data you want to apply the formula to. 
 
I will give you the formula below, but in order for it to work, you must ONLY add the formula to 
the first empty cell in that column. If any of the other rows in that column have anything in 
them, it will NOT work. Again, all of the rows BELOW the cell that has the formula in it MUST be 
empty! And you must place the formula in the top-most empty cell in the column, or the resulting 
data will be for a different song. The formula places its result into the cells ONLY if they are 
empty. 
 
Since the song length data from Spotify is in milliseconds, I suggest renaming that original 
column to "LENGTH (ms)", and name a new empty column to "LENGTH". Again, the empty column is the 
one where the formula needs to be added to the first empty cell, right below the ROW 1 header. 
 

http://www.noyou.net/spotify/


 
In the formula below, replace all of the C's with the letter of the COLUMN that the original 
length in milliseconds is in. Replace all of the R's with the number of the ROW that the formula 
is in (most likely 2). 
 
This is the SONG LENGTH CORRECTION FORMULA: After modifying it using the above instructions (by 
replacing the C's & R's as described above), copy and paste it into the first empty cell of the 
column you want your proper song lengths to display in: 
 
​ =ArrayFormula(if(CR:C="",,CR:C/3600000/24)) 
 
For example, I will describe the order I arranged my columns into: 
 
First, I deleted all columns I have no need for. Then I moved them into the order shown below.  
 
Notice below that I moved my milliseconds column, now named LENGTH (ms), to the COLUMN E 
position, because I do not care to ever see it. The only columns I want to see when I am done 
are columns A, B, C, & D. The other three columns still need to be there for the formulas to 
work, but I will “hide” them after sorting the contents or the song name column to alphabetical 
order. The formulas reference the data stored in these columns in order to display things 
properly in the columns that are not hidden. 
 
COLUMN A is for the "ARTIST" 
 
COLUMN B is for the "SONG TITLE" (this is a column that will contain a formula in its first 
empty cell) 
 
COLUMN C is for the "LENGTH" (this is a column that will also contain a formula in its first 
empty cell) 
 
COLUMN D is for the "DATE ADDED" (the day the song was added to the playlist) 
 
COLUMN E is for the original "LENGTH (ms)". I "hide" this column so it does not show in the 
completed spreadsheet, but it must still be there for COLUMN C to display properly after the 
appropriate formula is applied to the first empty cell of COLUMN C. 
 
COLUMN F is for the “Track Preview URL” for each song. I also “hide” this column. The links in 
this column get combined with the song titles in COLUMN G, which results in a clickable song 
title being displayed in COLUMN B, after the appropriate formula is applied to the first empty 
cell in COLUMN B. 
 
COLUMN G is for the song titles. I also “hide” this column. The song titles in this column will 
be combined with the links in COLUMN F, with the resulting clickable song titles appearing in 
COLUMN B, after the appropriate formula is applied to the first empty cell of COLUMN B. 

 



 
As you recall, we froze ROW 1 so it will always stay on top as ROW 1. Since ROW 1 contains the 
HEADER information describing what is in that column, ROW 2 is the next available ROW for our 
song data. Therefore, the first empty cell available in COLUMN C is in ROW 2. So in the formula 
above, the C's (Column) will be replaced by E's (referencing COLUMN E, where the song length in 
milliseconds is located for each song), and the R's (Row) will be replaced with 2's, for ROW 2. 
 
So in my case, my formula is this: 
 
​ =ArrayFormula(if(E2:E="",,E2:E/3600000/24)) 
 
After copying and pasting the above formula into the first empty cell of COLUMN C (in my case), 
all of the cells in that column now become populated with the calculated song length data. 
 
In order to display a proper song length in minutes and seconds, this column must now be 
formatted in a few different ways. 
 
For these "formatting" tasks, make sure your "LENGTH" column is highlighted. Do this by clicking 
on the letter of that column. 
 
​ 1) Click on the "Format" menu item at the top. 
 
​ 2) Click on "Number". 
 
​ 3) Click on "Duration". 
 
That was the first part of formatting the result. Now to the second and last part... 
 
​ 1) Click on the "Format" menu item at the top (again). 
 
​ 2) Click on "Number" (again). 
 
​ 3) Click on "m:ss". 
 
Now your new LENGTH column should show the song lengths in the standard mm:ss format. 

 



 
The below formula is the COMBINE SONG NAME WITH SONG SAMPLE LINK formula. It will be displayed 
in a new column of your choice (again, I suggest SONG TITLE - Rename the original SONG TITLE 
column to something like “Unlinked Song Title”) 
 
This will result in the SONG TITLE being displayed as a clickable link to a  30 second sample of 
that song. Place the below formula into the first empty cell of the column you want the song 
title displayed in (SONG TITLE in my case), which will also end up as a link to the song sample 
if the viewer clicks on it. In my case, as shown above, I would place it in COLUMN B), and as 
with the above formula example, place it in the first empty row, and make sure all of the 
following rows for that column are empty: 
 

=ArrayFormula(IF(G2:G="",,HYPERLINK(F2:F,G2:G))) 
 

* where 2 signifies ROW 2. 
 
* where F signifies COLUMN F, where the song preview URLs (addresses) are. 
 
* where G signifies COLUMN G, where the song titles are. 
 
 
To export it as a webpage, or to SHARE it as a link, like I did, follow these steps: 
 

1)​ I recommend first sorting the song titles by clicking on the song title column so 
the whole column is highlighted, then click on DATA, then on SORT SHEET, then select 
Sort by Column B (A to Z). That is assuming your column B is where your SONG TITLEs 
are. After sorting it, you can now hide it. 

2)​ Next, I recommend sorting the artist name by clicking on the ARTIST column so the 
whole column is highlighted, then click on DATA, then on SORT SHEET, then select 
Sort by Column A (A to Z). That is assuming your column A is where your ARTISTs are. 

3)​ To share it as a link, click on FILE, then SHARE, then PUBLISH TO WEB. Click on 
LINK, select ENTIRE DOCUMENT, then click on PUBLISH. Copy and paste it to a shortcut 
on your desktop, to a text file, an email to yourself, or wherever, so you will have 
access to this link in whatever way you prefer. 

4)​ To download a webpage (HTML) file, click on FILE, DOWNLOAD, WEBPAGE (HTML). 

 


